
Incidents - managing incidents and initial reports
This chapter explains how to create and modify incidents and initial reports, 
create and modify detail requests, and create incident lists. The type of 
activities you can perform include:

• Understanding Initial Reports and Incidents
• Creating and modifying Initial Reports
• Creating and modifying Incidents
• Creating and modifying Detail Requests
• Creating Incident Lists.

Understanding Initial Reports and Incidents
ROSS allows you to enter and manage information about both emergency and 
non-emergency events. An event may either be initially entered as an Incident 
or as an Initial Report that is later “promoted” to an Incident. Remember these 
key points when working with Initial Reports and Incidents:

• Create an Initial Report to document information about an event that has 
not been confirmed as an Incident

• Create an Incident for an event for which resources will be dispatched. 
• A dispatch unit that uses ROSS can create an “External Incident” for a 

dispatch unit that does not use ROSS.
• You can not create an “External Initial Report.”
• Initial Attack operations are performed outside of ROSS.
• Initial Reports and Incidents are numbered in the following format:  

[Host ID]-[999999].

If you are unsure of whether to create an Initial Report or an Incident to 
document the event, create an Initial Report. Later, you can promote the Initial 
Report to an Incident.

Creating and modifying Initial Reports
An Initial Report allows you to document information about an event that has 
not been confirmed as an incident. Initial Reports are numbered in the 
following format: [Dispatch ID] - 999999

For example, an Initial Report may be numbered “MT-PSD-000012.”

You cannot dispatch resources to an Initial Report. You must first promote it to 
an Incident. For more information, see “To promote an Initial Report to an 
Incident,” later in this chapter.
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To access the New Initial Report or Incident screen
• On the Incident menu, click New Initial Report or Incident, or click the 

NI button.

New Initial Report or Incident screen

To create an Initial Report

Once you create an Initial Report, you can close it but you cannot delete it.

1 On the New Initial Report or Incident screen, type the name of the 
person who reported the event in the Reported By box.

2 In the Description box, type a brief description of the event.

You can enter complete details of the event in the Enter Documentation 
box, which is located at the bottom of the screen.
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3 Click the Type drop-down arrow and highlight to select the event type

- Emergency Report
- Hazardous Materials
- Law Enforcement
- Medical
- Natural Disaster
- Other
- Prescribed Fire
- Preparedness/Positioning
- Special Event
- Structure Fire
- Search and Rescue
- Training
- Wildland Fire.

4 Click the Incident Host drop-down arrow and select the appropriate 
Organization serving as the Incident Host.

This is an required entry when creating an internal Incident.

5 In the Office Reference box, type the local office number assigned to the 
event, if desired.

6 Under Enter Location, type the new or existing location of the event.

This is an optional entry when creating an Initial Report. For more 
information, refer to the section, “Entering Coordinates,” in “Airports - 
working with airport information.”

7 Click in the Enter Documentation box, and then type detailed 
information about the event, as appropriate.

8 When finished, click the Initial Report button.

The Sequence Next Value is a number automatically assigned to the 
Initial Report. You cannot change this number.

To clear screen entries

Once an Initial Report has been saved, you cannot undo the changes. To edit 
an Initial Report, see the task, “To edit an Initial Report,” later in this section.

• Click the Undo New Initial Report or Incident button.
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To review an existing Initial Report
1 On the Incident menu, click Initial Report.

2 Highlight to select the Initial Report of your choice.

The following diagram shows the Initial Report screen.

Only Initial Reports created by your organization display on your screen.

To search for an Initial Report

You do not need to enter any search criteria to perform a search. Simply click 
Search on the Search Initial Reports dialog box to search for all Initial 
Reports.

1 On the Initial Report screen, click the Search button.

2 On the Search Initial Reports dialog box, type or select the appropriate 
information for as many text boxes as possible to narrow your search, and 
then click the Search button.
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The following diagram shows the Search Initial Reports dialog box.

To create a new Initial Report from the Initial Report screen

You can create a new Initial Report from the Initial Report screen or from the 
New Initial Report or Incident screen as explained in the task, “To create an 
Initial Report,” at the beginning of this chapter.

1 On the Initial Report screen, click New.

2 Complete the following information as appropriate

- Reported By
- Type
- Office Reference
- Description/Notes
- Location Name - optional
- Coordinates - optional.

3 When finished, click Save.

To edit an Initial Report
1 On the Initial Report screen, highlight to select the Initial Report of 

your choice.

2 Change the following information as appropriate

- Reported By
- Type
- Office Reference
- Description/Notes
- Location Name - optional
- Coordinates - optional.

3 When finished, click Save.
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To change the status of an Initial Report to “closed”
• On the Initial Report screen, highlight to select the Initial Report you 

want to close, and then click Close.

To change the status of an Initial Report to “open”
• On the Initial Report screen, highlight to select the Initial Report you 

want to open, and then click Open.

To promote an Initial Report to an Incident

You can only promote “open” Initial Reports that have location coordinates. 
Once you promote the Initial Report, the newly created Incident is assigned 
the next sequential event number for your unit.

1 On the Initial Report screen, highlight to select the Initial Report of 
your choice.

2 If not already entered, edit the Initial Report and complete the 
Coordinates, and then click Save.

3 Click the Promote button.

4 On the Select Incident Host dialog box in the Incident # box, type the 
Incident Number.

5 In the Promoted Incident Name box, type the new Incident Name.

6 If you do not want to use the default request number blocks associated 
with the host, click to clear the Use Host Default Request Number 
Block(s) check box.

For more information about request block numbers, see “Working with the 
Request Blocks tab,” in the section, “Completing Incident screen tabs.”

7 When finished, click OK.

The following diagram shows the Select Incident Host dialog box.
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To associate an Initial Report to an Incident

Perform this task when an Incident has been created that encompasses the 
event conditions for which the Initial Report was created. Associating an Initial 
Report to an Incident does not automatically close the Initial Report.

1 On the Initial Report screen, highlight to select the Initial Report of 
your choice, and then click the Associate button.

2 On the Associate to Incident dialog box, search for and highlight the 
Incident of your choice, and then click OK.

The following diagram shows the Associate to Incident dialog box. Clicking 
Search displays the current list of Incidents.

To add a documentation entry

Documentation is a permanent part of the Initial Report. Once you click the 
Add Documentation button, you can not edit nor delete the entry.

1 On the Initial Report screen, highlight to select the Initial Report of 
your choice, and then click in the lower left Documentation text box.

2 Type the appropriate text, and then click the Add Documentation button.

Creating and modifying Incidents
An Incident documents an event for which resources will be dispatched. You 
can only dispatch resources to Incidents, not to Initial Reports. This section 
explains the following topics:

• Understanding Incident context
• Understanding Incident numbering
• Understanding block numbering and rules
• Creating an Incident
• Editing Incident details
• Completing Incident screen tabs
• Creating an External Incident.
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Understanding Incident context
When you view most screens in ROSS, the information that displays is in 
relation to a specific Incident. This is known as the Incident “context.” You 
can change the Incident context of the screen you are currently viewing to 
display only local incidents created by your organization, without affecting 
the Incident context of any other open screens. In this way, you can specify a 
different Incident context for each open screen.

The following example outlines a way to use Incident context when you 
perform dispatching functions in ROSS:

1. You are about halfway through entering information for Local Incident A 
on the Incident screen.

2. In response to a phone call, you must create a resource request for Local 
Incident B by
- opening the New Request screen
- changing the Incident context on the New Request screen from Local 

Incident A to Local Incident B
- creating the request.

3. You then click the IN button to return to the Incident screen and finish 
entering the information for Local Incident A. Notice that the Incident 
screen remains in the context of Local Incident A.

To change the Incident context of the current screen
1 On the toolbar, click the Most Recent Incidents drop-down arrow, and 

then highlight to select the Incident of your choice.

2 Click the Show/Update Incident Context of the Current Screen button.

To return to an open Incident screen without changing its context
• Click the IN button.

Understanding Incident numbering
Incidents are numbered in the following format: [Host ID] - 999999

For example, an Incident may be numbered “CO-RMP-000012.”

The Create Incident portion of the New Initial Report or Incident screen 
displays three fields that pertain to Incident numbering:

• Sequence Next Value. Displays the next sequential Incident number, 
based on the selected host. The sequence for each host resets to “1” at the 
beginning of the calendar year. The Sequence Next Value is not 
applicable to external Incidents. 
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• View Issued #. Displays the View Issued Incident Numbers dialog box, 
which lists the Incident number, Host Dispatch, and Incident Name issued 
this calendar year for the selected host.

• Incident #. Allows you to substitute the Sequence Next Value with the 
Incident Number of your choice. Incident # is a required entry for external 
Incidents. Specifying the Incident # sets an initial/revised Sequence Value 
for the selected host, so that the Sequence Next Value for that host is the 
Incident # you specified, plus one (+ 1).

For more information about request block numbers, see “Working with the 
Request Blocks tab,” in the section, “Completing Incident screen tabs.”

Understanding block numbering and rules
Block numbering applies to Incident requests. When creating an Incident, you 
can apply the host’s template of block numbers to the Incident, although this 
is optional. You can then modify the blocks to suit the particular needs of that 
Incident, without affecting the master template for the host. You must 
designate each request block as one of the following:

• User Issued. Selecting a User Issued block allows you to designate the 
number to be assigned to the request. You cannot use User Issued blocks 
with Pre-Order requests. Individual Pre-Order requests are automatically 
numbered based on the system default block for that catalog.

• System Generated. Selecting a System Generated block allows ROSS to 
automatically assign the next available sequential number from that block 
of numbers to the request.

You can change system generated blocks to user issued blocks. You cannot 
change user issued blocks to system generated blocks.

Splitting one block into two

When you split one block into two, remember the following rules:

• If splitting a User Issued block, the resulting blocks must also be User 
Issued.

• If splitting s System Generated block, the resulting blocks can either be 
User Issued or System Generated. The Start number of the second 
resulting block must be greater than the next sequential available number 
of the original block.

You cannot create a System Generated block that already contains a 
“used” request number.

• If splitting a block that is not designated as a default, you cannot set either 
of the resulting blocks as default from the Split Block dialog box.

You may change the default settings on the Requests Blocks tab on the 
Incident screen.
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• If splitting a default block, you must select one of the resulting blocks to 
be the new default.

• The last block in each catalog must be a System Generated block with an 
End number of 999,999, the maximum number allowable.

For complete instructions see the task, “To create a new block by splitting an 
existing block into two,” in “Completing Incident screen tabs,” later in this 
chapter.

Deleting a request block

When you delete a request block, remember the following rules:

• There must always be at least one remaining block for each catalog.
• You cannot delete a block that is designated as a “SYS” or “R” default for 

the catalog. You must first designate a different block as the default 
before you can perform the delete.

• If deleting either the first or last block of a catalog, the block being 
deleted will be merged into the previous block.

• If deleting a block located between two other blocks, you must select 
which block you want the deleted block to be merged into.

• You cannot delete a block that an associated request.
• If an “SG” block is merged into a “UI” block, the remaining block is 

converted to “SG.”

For complete instructions see the task, “To delete a request block,” in 
“Completing Incident screen tabs,” later in this chapter.

Creating an Incident
You can create an Incident by:

• defining the event as an Incident, either internal or external
• promoting an Initial Report to an Incident.
To create an Incident by promoting an Initial Report, see “To an Initial Report 
to an Incident,” in “Creating and modifying Initial Reports,” earlier in this 
chapter.

To access the New Initial Report or Incident screen
• On the Incident menu, click New Initial Report or Incident, or click the 

NI button.

To review a snapshot of the New Initial Report or Incident screen, turn to 
page 2 in this chapter.
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To create an Incident
1 On the New Initial Report or Incident screen, type the name of the 

person who reported the event in the Reported By box.

2 In the Description box, type a brief description of the event.

You can enter complete details of the event in the Enter Documentation 
box, which is located at the bottom of the screen.

3 Click the Type drop-down arrow and highlight to select the event type

- Emergency Report
- Hazardous Materials
- Law Enforcement
- Medical
- Natural Disaster
- Other
- Prescribed Fire
- Preparedness/Positioning
- Special Event
- Structure Fire
- Search and Rescue
- Training
- Wildland Fire.

4 In the Incident Name box, type the name for the Incident.

5 Click the Incident Host drop-down arrow and select the appropriate 
Organization serving as the Incident Host.

6 In the Office Reference box, type the local office number assigned to the 
Incident, if desired.

7 Under Enter Location, type the new or existing location of the Incident, 
or click the Pick button to search for a location of your choice.

8 Click in the Enter Documentation box, and then type detailed 
information about the Incident as appropriate.

9 To specify a new Incident number, type the new Incident Number in the 
Incident # box.

For more information about specifying an Incident Number, see 
“Understanding Incident Numbering,” previously in this section.

10 If you do not want the new Incident to appear in the Most Recent 
Incidents list, click to clear the Add to Most Recent Incident List check 
box.

11 If you do not want to use the default request number blocks associated 
with the host, click to clear the Use Host Default Request Number 
Block(s) check box.
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12 To view the default Incident request numbers for a Catalog, click the 
View Default Request Blocks button, click the Catalog drop-down 
arrow, and then click to select the Catalog of your choice. Click Close 
when finished.

For more information about request block numbers, see “Understanding 
request block numbering and rules,” previously in this section.

13 When finished entering Incident information, click the Incident button.

The following diagram shows the View Default Request Number Blocks 
dialog box.

To access the Incident screen
• On the Incident menu, click Incident or click the IN button.
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Incident screen

To review an existing Incident from the Incident List
1 On the Incident menu, click Incident List, or click the IL button.

2 Highlight to select the Incident of your choice, and then click the  
Go To Incident button.

Editing Incident details
Once an Incident is created, you can add and/or change the following 
information:

• Incident Name
• Office Reference
• Initial Date/Time with time zone
• Estimated End Date/Time with time zone
• Type.
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To edit information for the most recent Incident
1 Click the IN button, and then click the Edit Incident button.

2 On the Edit Incident dialog box, type or replace any of the following 
information and then click OK

- Name
- Office Reference
- Initial Date Time
- Estimated End Date Time
- Type.

3 To edit location information, click Edit Location, and then type or 
replace the Location Name and Coordinates as appropriate, and then 
click OK.

The following diagram shows the Edit Incident dialog box.

The following diagram shows the Edit Location dialog box.

To relate an Incident to your Incident
1 On the Incident screen, click the Related Incidents button, and then 

click New.
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2 Under Relationship on the New Related Incident dialog box, click to 
select the relationship to be established to your Incident

- Follow-On, to link a subsequent Incident to your Incident
- Predecessor, to link a previous Incident to your Incident
- Associated, to link another Incident to your Incident without 

establishing which one was created first.

3 Search for and select the Incident that you want to relate to your Incident, 
and then click OK.

The following diagram shows the New Related Incident dialog box.

The following diagram shows the Related Incidents dialog box.

To remove a related Incident from your Incident
1 On the Incident screen, click the Related Incidents button.
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2 On the Related Incident dialog box, highlight to select the related 
Incident of your choice, and then click Delete.

3 On the Confirm Deletion dialog box, click Yes, and then click OK to 
return to the Incident screen.

To view Associated Initial Reports
1 On the Incident screen, click the Related Initial Reports button.

2 On the Associated Initial Reports dialog box, click New.

3 Search for and select the Initial Report that you want to associate to your 
Incident, and then click OK.

The following diagram shows the Associated Initial Reports dialog box.

The Promoted Initial Report group box displays information for an Incident 
that started out as an Initial Report.
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The following diagram shows the Associate Initial Report dialog box.

To remove an associated Initial Report from your Incident
1 On the Incident screen, click the Associated Initial Reports button.

2 On the Associated Initial Reports dialog box, highlight to select the 
related Initial Report of your choice, and then click Delete.

3 On the Confirm Deletion dialog box, click Yes, and then click OK to 
return to the Incident screen.

To print a report of Incident information
1 On the Incident screen, click the Print Incident button.

2 On the File menu, click Print.

3 On the Print dialog box, click the Print button, and then click Close.

For more information about printing reports and Brio software, see the 
chapter, “Reports - generating and printing reports.”

Completing Incident screen tabs
The middle and lower portions of the Incident screen displays eleven tabs that 
allow you to review additional incident details:

• Navigation Aids
• Aviation Hazards
• Financial Codes
• Compact
• Locations
• Frequencies
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• Airports
• Directions
• Contacts
• Organizations
• Documentation.

Understanding the Navigation Aids tab

The Navigation Aids tab displays two tables of available navigation aids 
nearest to the Incident:

• The VOR table, imported with FAA airport data, displays the ten nearest 
VORs and the associated VOR Names, States, Bearings, and Distances 
based on the Incident location coordinates. 

By reviewing the general location of the VORs, you can determine 
whether the Incident location coordinates were entered correctly.

• The Reload Bases table displays the Airport Name, FAA Code, City, and 
State of nearby Reload Bases as entered by your organization on the 
Organization screen.

The diagram below shows the Navigation Aids tab on the Incident screen. The 
VOR table is on the left and the Reload Bases table is on the right.

Working with the Aviation Hazards tab

The Aviation Hazards tab displays the type, location coordinates, and 
description of fixed-location aviation hazards within approximately 20 miles 
of the Incident and non-fixed aviation hazards entered for the Incident.

The type of aviation hazards that displays depends on the option you select, 
either “Fixed Hazard” or “Non-Fixed Hazard.”

To add an Aviation Hazard
1 On the Incident screen, click the Aviation Hazards tab, and then click 

New.

2 To define a permanent hazard, click to select Fixed Hazard. To define a 
temporary hazard, click to select Non-Fixed Hazard.

An example of a Non-Fixed Hazard includes smoke, a logging tower, or 
congested airspace.
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3 Click the Hazard Type drop-down arrow and select the hazard type of 
your choice.

4 In the City text box, type the name of the city nearest to the aviation 
hazard.

5 In the State Code text box, type the state postal code where the aviation 
hazard is located.

6 In the Description text box, type a brief description of the aviation 
hazard.

7 Under Coordinates, perform one of the following

- to designate the aviation hazard with the same coordinates as the 
Incident, click the Use Incident Location button 

- to designate the aviation hazard with different coordinates as the 
Incident, click to select the Coordinate Type of your choice and then 
complete the coordinate text boxes as appropriate.

8 When finished entering aviation hazard information, click OK.

The following diagram shows the New Aviation Hazard dialog box.

To modify Aviation Hazard information
1 On the Incident screen, click the Aviation Hazards tab.

2 On the Aviation Hazards tab, click Fixed Hazard or click Non-Fixed 
Hazard.

3 Click to select the Aviation Hazard of your choice, and then click Edit.

4 On the Edit Hazard dialog box, type or replace the following Aviation 
Hazard information as appropriate

- Hazard Type
- City
- State Code
- Description
- Coordinates.
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5 To save your modifications, click OK.

The following diagram shows the Edit Hazard dialog box.

To remove an Aviation Hazard
1 On the Incident screen, click the Aviation Hazards tab.

2 On the Aviation Hazards tab, click Fixed Hazard or click Non-Fixed 
Hazard.

3 Click to select the Aviation Hazard of your choice, and then click 
Delete.

4 On the Confirm Deletion dialog box, click Yes to confirm or No to 
cancel.

Working with the Financial Codes tab

The Financial Codes tab displays financial codes and their owners for a 
specified year, as entered by your organization on the Organization screen. An 
asterisk (*) identifies those financial codes that have ever been used.

To designate or remove Financial Codes for the Incident
1 On the Incident screen, click the Financial Codes tab.

2 Click the Organization drop-down arrow and select the Organization of 
your choice.

3 Click the Year drop-down arrow and select the Year of your choice.

4 To designate a Financial Code for the Incident, highlight to select the 
Financial Code of your choice from the left-hand table, and then click 
the Select arrow button. Repeat the process to move all appropriate 
Financial Codes to the table on the right.

5 To remove Financial Codes designated for the Incident, highlight to 
select the Financial Code of your choice from the right-hand table, and 
then click the Remove arrow button. Repeat the process to remove all 
appropriate Financial Codes from the table on the right.
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6 To designate the default Financial Code for the Incident, highlight to 
select the Financial Code of your choice from the right-hand table, and 
then click the Make Default button.

You may designate only one default Financial Code.

The following diagram shows the Financial Codes tab on the Incident screen.

To add a new Financial Code

Ad hoc financial codes are not retained once the Incident is closed.

1 On the Incident screen, click the Financial Codes tab, and then click 
New.

2 In the Financial Code box, type the Financial Code you want to add.

3 In the Fiscal Year box, type the four-digit Fiscal Year.

4 Under Owned By, click to select the agency type of your choice

- Federal
- State
- Other.

5 Under Owned By, click the drop-down arrow and select the 
Organization of your choice, and then click OK.

The following diagram shows the Ad Hoc Financial Code dialog box.

Completing the Compact tab

This feature is not yet installed.
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To access the Compact tab
1 On the Incident screen, click the Compact tab.

The following diagram shows the Compact tab on the Incident screen.

Working with the Locations tab

The Locations tab displays the locations that are being used to designate and 
describe places of importance to the Incident, as entered by your organization 
on the Location screen. Each location identifies:

• Location Use, such as a command post or a delivery site
• Location Name
• Type, such as a dip site, lookout, or helibase
• City
• State.

You can add a Location to an Incident by performing one of the following:

• Select an existing location and then add it to the Incident.
• Select an existing location, modify and save it as a new location, and then 

add it to the Incident.
• Create a new location and then add it to the Incident.

To make changes to a Location, you must access the Location screen from 
the Administration menu. You can not modify Location information from the 
Incident screen. For more information, refer to the chapter, “Location - 
defining geographic locations,” in the ROSS Administration section, earlier in 
this guide.

To add an existing Location to an Incident
1 On the Incident screen, click the Locations tab, and then click New.

2 On the Add New Location dialog box, search for and locate Locations 
near the Incident.

3 To add an existing location, highlight to select the Name of your choice 
and then click OK.
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The following diagram shows the Add New Location dialog box.

To modify an existing location and add it as a new Location to an 
Incident
1 On the Incident screen, click the Location tab, and then click New.

2 On the Add New Locations dialog box, search for and locate Locations 
near the Incident.

3 Highlight to select the Name of your choice, and then type or replace the 
Location information as appropriate.

4 Click Save, and then click OK.

To create and add a new Location to an Incident
1 On the Incident screen, click the Location tab, and then click New.

2 On the Add New Location dialog box, search for and locate Locations 
near the Incident, and then click New.

You must search for existing locations before creating a new one.

3 In the Location Name box, type the name of the location.

4 Click the Location Type drop-down arrow and select the Location Type 
of your choice.

5 In the City box, type the name of the nearest City of the location.

6 In the State box, type the two-character State postal code.
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To change the use of a Location at an Incident
1 On the Incident screen, click the Locations tab, and then highlight to 

select the Location of your choice.

2 Click the Location Use drop-down arrow and select the Location Use of 
your choice, and then click Save.

To modify or add navigation instructions to a Location
1 On the Incident screen, click the Locations tab, and then highlight to 

select the Location of your choice.

2 Click in the Navigation Instructions box, type or replace the Navigation 
Instructions as appropriate, and then click Save.

To delete a Location from an Incident
1 On the Incident screen, click the Locations tab.

2 Highlight to select the Location of your choice, and then click Delete.

3 On the Confirm Deletion dialog box, click Yes to delete or No to cancel.

Working with the Frequencies tab

The Frequencies tab displays radio frequencies available for the Incident, 
including:

• Type
• Frequency
• Tone
• Contact Name
• Owner.

To designate a new frequency for an Incident
1 On the Incident screen, click the Frequency tab, and then click New.

2 On the New Radio Frequency dialog box, click the Type drop-down 
arrow and select the Type of the new radio frequency.

3 In the Frequency box, type the Frequency.

4 In the Tone box, type the Tone of the radio frequency.

5 In the Contact box, type the name of the person, aircraft, or agency to 
Contact on this radio frequency.

6 In the Owner box, type the name of the Owner, if needed.

7 Click to clear the Primary check box if this radio frequency is not a 
primary frequency on the Incident.

8 When finished, click OK.
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The following diagram shows the Frequencies tab on the Incident screen.

The following diagram shows the New Radio Frequency dialog box.

To change a radio frequency for an Incident
1 On the Incident screen, click the Frequency tab, and then highlight to 

select the Frequency of your choice.

2 Edit the following fields as appropriate:

- Type
- Frequency
- Tone
- Contact
- Primary.

3 When finished, click OK.
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The following diagram shows the Edit Radio Frequency dialog box.

To delete a radio frequency for an Incident
1 On the Incident screen, click the Frequency tab.

2 Highlight to select the Frequency of your choice, and then click Delete.

3 On the Confirm Deletion dialog box, click Yes to delete or No to cancel.

Working with the Airports tab

The Airports tab displays FAA and non-FAA airports being used on the 
Incident. Each airport identifies:

• Airport Type, such as a charter, commercial, or back country airport
• Airport Name
• FAA Code, if applicable
• City
• State.
The Special Conditions box displays information that was entered from the 
Airport screen. To add, modify, or delete Special Conditions, you must access 
the Airport screen from the Administration menu.

To edit or add navigation instructions for an airport
1 On the Incident screen, click the Airports tab.

2 Click to select the Airport of your choice.

3 Click in the Navigation Instructions box, type or replace the Navigation 
Instructions as appropriate, and then click Save.
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The following diagram shows the Airports tab.

To designate an airport to the Incident
1 On the Incident screen, click the Airports tab, and then click New.

2 On the Add New Locations dialog box, search for and locate Airports 
near the Incident.

3 Click to select the Airport of your choice, and then click OK.

To remove an airport from an Incident
1 On the Incident screen, click the Airports tab.

2 Click to select the Airport of your choice, and then click Delete.

3 On the Confirm Deletion dialog box, click Yes to delete or No to cancel.

This action only removes the designated airport from the incident. It does 
not delete it from ROSS. To delete a non-FAA airport from the list of 
airports for your organization, you must access the Airport screen from 
the Administration menu.

To create a non-FAA airport and designate it to the Incident

You can only add locally defined airports (non-FAA) to the ROSS database.

1 On the Incident screen, click the Airports tab, and then click New.

2 On the Add New Airport dialog box, search for and locate Airports near 
the Incident, and then click New.

You must search for existing airports before you can create a new non-
FAA airport.

3 In the Airport Name box, type the name of the new non-FAA airport.

4 In the City box, type the name of the nearest City of the airport.

5 In the State box, type the two-character State postal code.
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6 Click the Airport Type drop-down arrow and select the Airport Type of 
your choice.

7 Under Coordinates, click to select the Coordinate Type of your choice, 
an then complete the coordinates, as appropriate.

For more information about entering coordinates, see “Entering 
coordinates,” in “Getting starting with ROSS.”

The following diagram shows the Add New Airport dialog box.

Working with the Directions tab

The Directions tab displays directions entered for the Incident.

To add directions for an Incident
1 On the Incident screen, click the Directions tab.

2 Click in the Directions box, type detailed Directions to the Incident, and 
then click Save.

The following diagram shows the Directions tab on the Incident screen.
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To edit directions for an Incident
1 On the Incident screen, click the Directions tab.

2 Click in the Directions box, type to add or replace the Directions to the 
Incident, and then click Save.

Working with the Contacts tab

The Contacts tab displays agency and individual contacts and telephone 
numbers for an Incident.

To add a new Contact for an Incident
1 On the Incident screen, click the Contacts tab, and then click New.

2 On the New Incident Contact dialog box, type the Contact and 
Telephone information, and then click OK.

The following diagram shows the New Incident Contact dialog box.

The following diagram shows the Contacts tab on the Incident screen.

To change a Contact for an Incident
1 On the Incident screen, click the Contacts tab.

2 Click to select the Contact of your choice, and then click Edit.

3 On the Edit Incident Contact dialog box, modify the Contact and 
Telephone information as appropriate, and then click OK.
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The following diagram shows the Edit Incident Contact dialog box.

To delete a Contact for an Incident
1 On the Incident screen, click the Contacts tab.

2 Click to select the Contact of your choice, and then click Delete.

3 On the Confirm Deletion dialog box, click Yes to delete or No to cancel.

Working with the Organizations tab

The Organizations tab displays the host, benefitting, dispatch, and billing 
organizations for the Incident:

• The host organization has primary management responsibility for the 
Incident. You cannot change the host or the number of an Incident when it 
has outstanding requests.

• The benefiting organization directly benefits from the activities occurring 
at the Incident.

• The dispatch organization is the unit designated to mobilize resources to 
the Incident.

• The billing organization is responsible for paying expenses related to the 
Incident.

The Organizations tab also displays the External Dispatch Unit of External 
Incidents.

The following diagram shows the Organizations tab on the Incident screen.
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The following diagram shows the Organizations tab on the Incident screen for 
External Incidents.

To select or change a Host organization
1 On the Incident screen, click the Organizations tab, and then click the 

Pick Host button.

2 On the Select Incident Organization dialog box, search for and then 
highlight to select the Host Organization of your choice, and then click 
OK.

The following diagram shows the Select Incident Organizations dialog box.

You cannot change the host or the number of an Incident when it has 
outstanding requests.

You cannot change the number of an External Incident.
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To display the Incident numbers issued this calendar year for the 
selected host
1 On the Incident screen, click the Organizations tab, and then click Pick 

Host.

2 On the Select Incident Organization dialog box, search for and then 
highlight to select the Host Organization of your choice, and then click 
the View Issued # button.

The following diagram shows the View Issued Incident Numbers dialog box.

To specify a new number for an Incident, based on the new host
1 On the Incident screen, click the Organizations tab, and then click Pick 

Host.

2 On the Select Incident Organization dialog box, search for and then 
highlight to select the Host Organization of your choice,.

3 In the Incident # box under Incident Numbering, type the new Incident 
# of your choice, and then click OK.

You are setting the initial/revised Sequence Value for the selected host. 
The Sequence Next Value for that host will be the Incident # you entered, 
plus one (+ 1).
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The following diagram shows the Select Incident Organizations dialog box. 
The arrow points to the new Incident # box.

When you change the Incident host, financial codes and radio frequencies 
assigned to the Incident remain unchanged.

To select a Benefiting organization
1 On the Incident screen, click the Organizations tab, and then click Pick 

Benefiting.

2 On the Select Incident Organization dialog box, search for and then 
highlight to select the Host Organization of your choice, and then click 
OK.

To select a Dispatch organization
1 On the Incident screen, click the Organizations tab, and then click Pick 

Dispatch.

2 On the Select Incident Organization dialog box, search for and then 
highlight to select the Host Organization of your choice, and then click 
OK.

To select a Billing organization
1 On the Incident screen, click the Organizations tab, and then click Pick 

Billing.
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2 On the Select Incident Organization dialog box, search for and then 
highlight to select the Host Organization of your choice, and then click 
OK.

To select an External Dispatch Organization - for  External 
Incidents only
1 On the Incident screen, click the Organizations tab, and then click Pick 

External Dispatch.

2 On the Select Incident Organization dialog box, search for and then 
highlight to select the External Organization of your choice, and then 
click OK.

Working with the Documentation tab

The Documentation tab displays information previously entered for the 
Incident. The table displays the time the entry was made and who made the 
entry. 

To add Documentation
1 On the Incident screen, click the Documentation tab.

2 In the Documentation box, type the documentation information as 
appropriate, and then click the Add Documentation (+) button, to save 
your entry.

Once saved, a documentation entry can not be modified nor deleted.

The following diagram shows the Documentation tab on the Incident screen.

To review the entire text of a Documentation entry
• On the Incident screen, click the Documentation tab, and then highlight 

to select the Documentation row of your choice.

The entire Documentation entry displays in the lower, right-hand box.
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Working with the Request Blocks tab

The Request Blocks tab allows you to specify the numbers assigned to 
requests created for an Incident. Block numbering is based on the host 
organization. Using the ROSS Organization screen, each managing dispatch 
unit establishes a master “template” of blocks for each catalog: Aircraft, 
Crews, Equipment, Overhead, and Supply.

The Request Blocks table displays the following information:

• Default. The default block for the selected catalog. An “R” denotes 
Request Default block. An “SYS” denotes System Default block.

• Type. The type of block. An “UI” denotes User Issued. An “SG” denotes 
System Generated.

• Block Name. The name of the block.
• Purpose. The purpose of the block.
• Start. The starting number of the block.
• End. The ending number of the block.
• Next. The next sequential number available in the block.
• Remaining. The number of request numbers available for use in the 

block.

For more information about request block numbering, see the previous 
section, “Understanding request block numbering and rules,” earlier in this 
chapter.

To set the default block to Request Default or System Default
1 On the Incident screen, click the Request Blocks tab, and then click the 

Default button.

2 Click to select either Set Request Default or Set System Default as 
appropriate.

The following diagram shows the Request Blocks tab.
October 13, 2004 version 2.1.1 35



ROSS User’s Guide Incidents - managing incidents and initial reports
To create a new block by splitting an existing block into two

For more information about block numbering, see “Understanding block 
numbering and rules,” in the previous section, “Creating and modifying 
Incidents.”

1 On the Incident screen, click the Request Blocks tab.

2 Click the Catalog drop-down arrow, click to select the Catalog of your 
choice, and then click the New button.

3 In the Start Block #2 At box, type the starting number of the block you 
are creating (Block #2).

4 Under Block #1 in the Name box, type a new name for Block #1, if 
appropriate.

This step is optional.

5 In the Purpose box, type or type to replace the Purpose of Block #1.

6 Under Default, click to select or click to clear the following check boxes

- Request
- System.

Changes must be consistent with the rules for designating default blocks.

7 If appropriate, click to select the User Issued check box.

Changes must be consistent with the rules for designating a block “SG” or 
“UI.”

8 Under Block #2, complete the following boxes and check boxes as 
instructed in the previous steps, and then click OK

- Name
- Start
- End
- Purpose
- Request
- System
- User Issued.
36 version 2.1.1 October 13, 2004



Incidents - managing incidents and initial reports ROSS User’s Guide
The following diagram shows the Split Block dialog box.

To edit a request block
1 On the Incident screen, click the Request Blocks tab

2 Click the Catalog drop-down arrow, click to select the Catalog of your 
choice, and then click the Edit button.

3 On the Edit Block dialog box, modify the following information as 
appropriate, and then click OK

- Name
- Purpose
- Request
- System
- User Issued.

For more the information about modifying these fields, see the previous 
task, “To create a new block by splitting an existing block into two.”
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The following diagram shows the Edit Block dialog box.

To delete a request block

For rules about deleting request blocks, see “Understanding block numbering 
and rules,” in the previous section, “Creating and modifying Incidents.”

1 On the Incident screen, click the Request Blocks tab.

2 Click the Catalog drop-down arrow, click to select the Catalog of your 
choice, and then click the Delete button.

3 On the Delete Block dialog box, click to select the block to merge the 
deleted block into, if appropriate, and then click OK.

The following diagram shows the Delete Block dialog box.
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Creating an External Incident
You can create an Incident for an external dispatch unit (does not use ROSS).

For more information about completing the New Initial Report or Incident 
screen, see the previous section, “Creating an Incident,” earlier in this 
chapter.

To create an External Incident
1 On the Incident menu, click New Initial Report or Incident, or click the 

NI button.

2 On the New Initial Report or Incident screen, click External Incident.

3 In the Incident Name box, type the name for the Incident.

4 Click the Type drop-down arrow and then click to select the Incident 
Type.

5 Click the Pick External Dispatch button, and then click to select the 
External Dispatch Unit of your choice.

For more information about creating or editing external dispatch units, see 
the next tasks, “To create an external dispatch unit” and “To edit an 
external dispatch unit.”

6 In the Contact Person box, type the name of the contact person from the 
external dispatch unit.

7 In the Contact Phone # box, type the contact person telephone number.

8 To change the Contact Date/Time when the external dispatch unit 
contacted your ROSS dispatch unit, click the Contact Date/Time button 
to change the date and time of the external dispatch contact.

9 In the Office Reference box, type the local office number assigned to the 
Incident, if desired.

10 In the Location Name box, type the location of the Incident.

11 Under Enter Coordinates, click to select the Coordinate Type of your 
choice, or click Pick Location, and then complete the location 
coordinates as appropriate.

12 On the Select External Dispatch Unit dialog box, search for and 
highlight the external dispatch unit of your choice, and then click OK.

If the external dispatch unit that you want is not listed, click the New 
button and then create a new external dispatch unit. For more information 
about creating an external dispatch unit, see the task, “To create an 
external dispatch unit,” later in this section.

13 Click in the Enter Documentation box, and then type detailed 
information about the Incident as appropriate.
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14 In the Incident # box, type the number of the Incident as assigned by the 
external dispatch unit.

You are setting the initial/revised Sequence Value for the selected host. 
The Sequence Next Value for that host will be the Incident # you entered, 
plus one (+ 1).

15 If you do not want the new Incident to appear in the Most Recent 
Incidents list, click to clear the Add to Most Recent Incident List check 
box.

16 If you do not want to use the default request number blocks associated 
with the host, click to clear the Use Host Default Request Number 
Block(s) check box.

For more information about request block numbers, see “Working with the 
Request Blocks tab,” in the section, “Completing Incident screen tabs.”

17 When finished entering the external Incident information, click the 
Incident button.

The following diagram shows the New Initial Report or Incident screen for 
creating an external Incident.
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The following diagram shows the Select External Dispatch Unit dialog box.

To create an external dispatch unit
1 On the Incident menu, click Incident or click the IN button.

2 Click External Incident, click the Pick an External Dispatch button, 
and then click New.

3 On the Non-ROSS Organization dialog box, type the name of the new 
external dispatch unit in the Dispatch Name box.

4 In the Unit Code box, type the Unit Code for the new external dispatch 
unit.

5 On the Contacts tab, click New, complete the Contact Method 
information as appropriate, and then click OK.

For more information about adding new contact information, see the next 
task, “To add new contact information.”

6 Click the Address tab, click New, complete the New Address 
information as appropriate, and then click OK.

For more information about adding new address information, see the 
task, “To add new address information.”

7 When finished, click OK 
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The following diagram shows the Non-ROSS Organization dialog box and the 
Contacts tab.

The following diagram shows the Non-ROSS Organization dialog box and the 
Address tab.

To add new contact information
1 On the Non-ROSS Organization dialog box on the Contacts tab, and 

then click New.

2 On the New Contact dialog box, click the Contact Method drop-down 
arrow and select the Contact Method of your choice.

3 Click the Priority drop-down arrow and select the Priority of your 
choice.

4 In the Entry box, type the appropriate entry for the new contact 
information.

5 Click OK to return to the Non-ROSS Organization dialog box, or click 
Apply to add the new contact information and then add another.
42 version 2.1.1 October 13, 2004



Incidents - managing incidents and initial reports ROSS User’s Guide
The following diagram shows the New Contact dialog box.

To add new address information
1 On the Non-ROSS Organization dialog box, click the Address tab, and 

then click New.

2 On the New Address dialog box, click the Type drop-down arrow and 
select the address type of your choice.

3 Complete the following information as appropriate

- Street 1
- Street 2
- City 
- State
- Zip Code
- Country.

4 Click OK to return to the Non-ROSS Organization dialog box, or click 
Apply to add the new address information and then add another.

The following diagram shows the New Address dialog box.

To edit or delete external dispatch unit information
1 On the Incident menu, click Incident or click the IN button.

2 Click External Incident, and then click the Pick an External Dispatch 
button.
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3 On the Select External Dispatch Unit dialog box, click to select the 
Dispatch Unit of your choice, and then click Edit.

4 On the Non-ROSS Organization dialog box, edit or delete the 
information of your choice, and then click OK.

Creating and modifying Detail Requests
A Detail is a pre-planned incident of a specific duration, and includes 
Prescribed Fire, Preparedness/Positioning, Special Event, and Training 
events. Other such events include:

• personnel assignments greater than or less than two weeks in duration
• flexible funding arrangements
• flexible travel and lodging arrangements
• personal days off without pay.

The Detailed Request screen allows you to specify what is needed for the 
Detail, known as “Positions,” and send out that information to selected 
organizations to find out if those required items can be obtained. You can 
create a single or multiple detail requests for a Detail.

You can not create a Detail Request for Wildland Fire and Structural Fire 
incidents.

To create a Detail Request

You can name the Detail Request the same name as the pre-planned 
incident, or select another name of your choice.

1 On the Incident screen, open the pre-planned incident (Detail) of your 
choice, click the Detail Request button, and then click New.

2 To change the default name of the request, type the new Detail Request 
Name in the Detail Request Name box.

The Detail Request Name box is located below the Broadcast, Requests, 
and Cancel buttons.

3 To select Start Date/Time and End Date/Time, click the Select Dates 
button, and then select the Start Date/Time and End Date/Time of your 
choice.

For more information about selecting starting and ending dates/times, 
see, “Using the Select Dates function,” in “Getting started with ROSS.”

4 To add a catalog item to the Detail Request, click the  
New Position button.
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5 On the Add Positions dialog box, click the Catalog drop-down arrow 
and select the Catalog of your choice.

To perform a search for a position, click the Search tab on the Add 
Positions dialog box, type the search criteria into one or more available 
boxes to narrow your search, and then click the Search button.

6 Click to select the Category Name and Catalog Item Name of your 
choice, and then click OK.

7 To specify the minimum acceptable qualification of the resource used to 
fill the new position, click the Minimum Rating button, on the Catalog 
tab click to select the Category Name and Catalog Item Name of your 
choice, and then click OK.

8 Complete the Requirements, Payment, Radio, Vehicles/Contacts, and 
Duty Station/Remarks tabs as appropriate.

For more information about completing tabs on the Detail Request 
screen, see the next section, “Completing Detail Request screen tabs.”

9 When finished completing all information, click Save Detail Request.

The following diagram shows the Detail Request screen.
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The following diagram shows the Catalog tab on the Add Positions dialog 
box.

The following diagram shows the Search tab on the Add Positions dialog box.
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The following diagram shows the Minimum Rating dialog box.

To search for a minimum qualification for a Position on a Detail 
Request
1 On the Detail Request screen, click to select the Position of your choice, 

and then click the Minimum Rating button.

2 On the Minimum Rating dialog box, click the Search tab.

3 Complete the boxes to narrow your search, and then click the Search 
button.

4 Click to select the Name of your choice, and then click OK.
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The following diagram shows the Search tab on the Minimum Rating dialog 
box.

To change the minimum qualification of a position
1 On the Detail Request screen under Positions, click to select the 

Position of your choice, and then click the Minimum Rating button.

2 On the Minimum Rating dialog box, click to select the Category Name 
and Catalog Item Name of your choice, and then click OK.

To change the quantity requested for a position
1 On the Detail Request screen under Positions, click to select the 

Position of your choice.

2 Click once in the Quantity box, type to replace the Quantity of your 
choice, and then click Save Position.

Completing Detail Request screen tabs
This section explains how to complete the tabs on the Detail Request screen, 
which allow you to further clarify the information on the Detail Request.

To complete the Requirements tab
1 Click the Employment Status drop-down arrow and select the 

Employment Status of your choice.
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2 Click to select the appropriate check boxes

- Agency Uniform
- Driver’s License Needed
- Travel outside Normal Duty Hours is Authorized/Compensated
- Personnel may be rotated
- Fire Resistant Clothing.

3 In the Established Workweek box, type the range of weekdays 
considered to be the workweek for the detail.

4 For temporary worker detail requests, type the name of the employment 
agency in the Employment Agency box.

5 Click the Endorsement drop-down arrow and select the appropriate 
endorsement, as needed

- Hazardous Materials
- Motorcycle
- Tank Vehicle
- Passenger
- Double/Triple Trailers.

6 In the Duty Hours box, type the number of Duty Hours expected for the 
position.

7 In the How Often? box, type the frequency of duty hours.

For example, to indicate 12-hour days, 4 times per week, type “12” in the 
Duty Hours box, and then type “4xweek” in the How Often? box.

The following diagram shows the Requirements tab on the Detail Request 
screen.

To complete the Payment tab
1 On the Detail Request screen, click the Payment tab.
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2 Under Payment, click to select either Sending Unit or Requesting Unit 
to specify the responsible unit for payment

- Rotation
- Travel
- Base Salary
- PerDiem
- Mileage
- F.O.R.

3 Click to select the appropriate check boxes

- Government Lodging Available
- Government Mess Hall Available
- Government Cooking Facility Only
- Commercial Lodging Available
- Commercial Meals Available
- Must be Self-Subsisting.

4 For Commercial Lodging Available, type the maximum rate that will be 
reimbursed, in dollars, in the Max. Lodging Rate ($) box.

5 For Commercial Meals Available, type the maximum rate that will be 
reimbursed, in dollars, in the M & IE Rate ($) box.

6 For Must be Self-Subsisting, type the maximum rate that will be 
reimbursed, in dollars, in the Estimated Total Cost ($) box.

The following diagram shows the Payment tab on the Detail Request screen.

To complete the Radio tab
1 On the Detail Request screen, click the Radio tab.

2 If radios are needed for the detail, click to select the Radios Needed 
check box, and then click New.

3 Under Radios, click in the Radio Type box, and then type the Radio 
Type.

4 Click in the Programmable box, and then click the drop-down arrow to 
select Yes or No for a programmable radio.

5 Click in the Quantity box, and then type the Quantity of your choice.
50 version 2.1.1 October 13, 2004



Incidents - managing incidents and initial reports ROSS User’s Guide
6 When finished, click Save.

The following diagram shows the Radio tab on the Detail Request screen.

To change radio information
1 On the Detail Request screen, click the Radio tab.

2 Under Radios, click to select the Radio Type of your choice.

3 Click to select the Radio Type, Programmable, and/or Quantity box, 
and then modify the information as appropriate.

4 When finished, click Save.

To delete a Radio Type
1 On the Detail Request screen, click the Radio tab.

2 Under Radios, click to select the Radio Type of your choice, and then 
click Delete.

3 On the Confirm Deletion dialog box, click Yes to confirm or click No to 
cancel.

To complete the Vehicles/Contacts tab
1 On the Detail Request screen, click the Vehicles/Contacts tab.

2 In the Vehicle Type box, type the Vehicle Type of your choice.

3 Click to select the appropriate check boxes, and then type the appropriate 
Quantity for each selected check box

- Agency Owned
- Privately Owned
- Retal Vehicle.

4 In the Electronic Tech’s Name and Phone box, type the name of the 
contact person and their phone number.

5 In the Personnel Officer and Phone box, type the name of the personnel 
officer and their phone number.
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6 In the Budget & Finance Officer and Phone box, type the name of the 
budget and finance officer and their phone number.

The following diagram shows the Vehicles/Contacts tab on the Detail Request 
screen.

To complete the Duty Station/Remarks tab
1 On the Detail Request screen, click the Duty Station/Remarks tab.

2 In the Requesting Unit’s E-mail Address box, type the email address of 
the requesting unit’s contact person.

3 In the Temporary Duty Station, type the name of the temporary duty 
station.

4 In the Address/PO Box box, type the complete street address of the 
temporary duty station.

5 In the Phone box, type the area code and telephone number of the 
temporary duty station.

6 In the Nearest Commercial Airline City, type the name of the city that 
has a commercial airport nearest to the temporary duty station.

The following diagram shows the Duty Station/Remarks tab on the Detail 
Request screen.
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Broadcasting a Detail Request
The Broadcast button allows you to email Detail Requests to a specific 
selection area or GACC. 

Your organization, and each organization defined in your selection area or 
GACC must have a primary email address defined in ROSS.

You do not have to broadcast a Detail Request.

To broadcast a Detail Request
1 On the Incident screen, open the pre-planned incident (Detail) of your 

choice, click the Detail Request button, and then click Broadcast.

2 On the Broadcast dialog box, click to select Selection Area or GACC as 
appropriate, and then click OK.

The following diagram shows the Broadcast dialog box.

Generating a Resource Request
You can generate a Resource Request for each Detail Request Position.

Once you generate a Resource Request for a Detail Request, you cannot 
cancel the Detail Request.

To generate a Resource Request from a Detail Request
1 On the Detail Request screen, select the Detail Request of your choice, 

and then click the Requests button.

2 To review the pending request, click Pending Request on the Request 
menu, and then search for the pre-planned incident (Detail) of your 
choice.
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Creating Incident Lists
The Incident List screen allows you to create a list of local Incidents that may 
be of particular interest and allows you to add local Incidents to your Most 
Recent Incidents drop-down list.

Remember, a local Incident is one created by your organization, and may be 
internal or external.

To access the the Incident List screen
• On the Incident menu, click Incident List or click the IL button.

Incident List screen

To view all Incidents that meet certain criteria
1 Under Filter Criteria for Incidents, type into or select information for as 

many boxes as possible to narrow your search

- Under Incident Status, click Open or Closed.
- Click the External check box to search for external incidents only.
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- Under Date Created, click the Select Dates button and then specifiy 
the period of time when the incidents were created.

- In the Incident # From and To boxes, type the specific number or 
range of numbers of the Incidents. 

- In the Incident Name box, type the name of the incident.
- Click the Host drop-down arrow, and then select the Incident Host of 

your choice.
- Click the Type drop-down arrow, and then select the Incident Type 

of your choice.
- For Incidents that have a changed host or Incident number, type the 

previous Incident Number in the Changed From box.
- To select a location, click the Pick button, search for and locate the 

Location Name of your choice on the Choose Location dialog box, 
and then click OK to return to the Incident List screen.

- To enter location coordinates, click the Coordinate Type of your 
choice, complete the appropriate boxes, and then type the distance in 
the Within ___ Miles box, from 2 to 10 miles.

2 When finished completing the criteria of your choice, click the Filter 
button.

Incidents that meet your filter criteria display under Incidents Meeting 
Criteria.

To display information for a selected Incident
1 Under Incidents Meeting Criteria, highlight to select the Incident 

Name of your choice, and then click the Go to Incident button.

2 To return to the Incident List screen from the Incident screen, click the 
Close Current Screen button.

To add an Incident to My Incident List

Adding Incidents to My Incident List has no impact to any other ROSS 
functions or screen. Its only use is to help you quickly view and organize 
Incidents that are of particular interest.

• Under Incidents Meeting Criteria, highlight to select the Incident 
Name of your choice, and then click the Add to My Incident List+ 
button. 

To remove an Incident from your Incident List
• Under My Incident List, highlight to select the Incident Name of your 

choice, and then click the Remove From My Incident List button.
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To add an Incident to your Most Recent Incidents drop-down 
menu
• Under Incidents Meeting Criteria or under My Incident List, highlight 

to select the Incident Name of your choice, and then click the Add to 
Most Recent button.

The following diagram shows two Incidents on the Most Recent Incidents 
drop-down toolbar menu.

To switch between local Incidents
1 On the Most Recent Incidents drop-down toolbar menu, highlight to 

select the Incident of your choice.

2 On the ROSS toolbar, click the Show/Update Incident context of the 
current screen button.

This button is located to the right of the IN button, next to the Most 
Recent Incidents drop-down toolbar menu.
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